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Chapter 1: Introduction

This is the user manual for the Windows BLL Generator. This product is used to generate platform and
application independent BLL files that can be used for imaging on remote Lasergraphics film recorders.

Windows BLL Generator supports PCs running Windows 95, Windows 98, Windows NT 4.0 and
Windows NT 5.0.

This chapter explains the features of the Windows BLL Generator.
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What You Need
You need the following hardware and software to run Windows BLL Generator:

Required Hardware
• Any IBM® PC compatible machine with a 486 processor or better, Pentium or better

recommended.

• 16 MB of memory when running Windows 95/98 and 32 MB when running Windows NT. More
memory may be required for complex images or images that contain large bitmaps.

• Minimum 4 megabytes of disk space for Windows BLL Generator programs plus additional
storage for images. The amount of additional storage required depends on the type of images.
Simple presentation slides will take between 100 kilobytes to 2 megabytes, complex and high-
resolution slides run from 5 megabytes up to 630 megabytes for a true color uncompressible
16000 line resolution image. Generally, 100 megabytes free disk space will be plenty.

Required Software
• Microsoft Windows 95, Windows 98, Windows NT 4.0 or Windows NT 5.0 operating system.

• A Windows application that can print to a Windows printer driver.
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About this Guide
This guide explains how to set up and use Windows BLL Generator.

This guide assumes that you already know how to use Microsoft Windows.  If you are new to Windows,
review your Microsoft Windows User’s Guide before proceeding.

Screen illustrations in this guide are meant to be representative, not necessarily exact duplicates of
screens that appear on your display.
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What’s new
Windows BLL Generator replaces Windows BLL Generator 3.15 for Windows 95 and WinRascol 3.15
for Windows NT. Major parts of Windows BLL Generator 3.15 were rewritten to increase performance,
simplify its use, and take advantage of new features of Windows 95 and Windows NT.

Windows BLL Generator offers these advantages over previous versions:

• One package supports Windows 95/98 and Windows NT 4.0/5.0

• Simple installation

• Same installation and interface on Windows NT and Windows 95/98

• Installation from hard drive or network

• Long filenames supported

• BLLs can be previewed

• A new high-compression BLL format generates smaller BLLs

� Note : Windows 3.1x is not supported by Windows BLL Generator. Windows BLL Generator
3.15 is the last version to support Windows 3.1x.

� Note: LFR and LFR+ type film recorders are not supported in Windows BLL Generator.
WinRascol 4.0 will continue to service this film recorder type.
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Windows BLL Generator Features
Windows BLL Generator  adds a new dimension to all of your visual communications by letting you
produce professional-quality presentation graphics—right at your desk.

Various Output Types
Windows BLL Generator takes images produced by any Windows application and prints the images on
a Lasergraphics LFR series film recorder to make 35mm slides, 35mm prints (negatives), Polaroid
prints, 6x7 cm or 4x5 film transparencies or prints (negatives).

Slides Transparencies

High-Resolution
With the Lasergraphics Film Recorder (LFR), Windows BLL Generator in combination with WinRascol
or MacRascol produces brilliant color images on film.  The LFR Mark VI  has a maximum resolution of
16384 lines which produces sharp images with over 700 times the image resolution (total number of
dots in an image) of a VGA screen.

Name Short 35mm resolution 120/220/4x5 resolution Available on

Fast 2k 2048x1365 2048x1680 All

Fine 4k 4096x2731 4096x3360 All

Extra 8k 8192x5461 8192x6719 Mark III and above

Ultra 16k 16384x10923 16384x13438 Mark VI

Download from Www.Somanuals.com. All Manuals Search And Download.



14 Introduction

True Color
Windows BLL Generator supports 24-bit color,  which enables you to produce life-like pictures with any
of over 16.7 million colors.  24-bit color refers to the way color information is stored in the image.  24-bit
color is sometimes called “true-color” because it reproduces the full range of color visible to the human
eye.

Easy to Use and Highly Compatible
Windows BLL Generator is compatible with all Microsoft Windows 95, Windows 98 and Windows NT
applications that provide the Print  command.  To print images the Windows BLL Generator, you simply
invoke the Print command from your Windows application.  Images will be sent from your application to
Windows BLL Generator for processing.
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Chapter 2: Express Setup

This section explains how users with previous WinRascol experience can get Windows BLL Generator
up and running quickly. If you are new the Windows BLL Generator or don’t consider yourself a
seasoned computer user, please take the time to study the chapters beginning with “Chapter 3:
Software Installation” on page 17.
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Installing Windows BLL Generator

Windows BLL Generator is freely available on the Lasergraphics web site www.lasergraphics.com. It is
also part of the WinRascol 4 distribution disks for convenience. Note that you may not distribute the
WinRascol 4 distribution disks or their contents. The Windows BLL Generator downloadable from
Lasergraphics' web site (www.lasergraphics.com) can be freely distributed. If you don’t have access to
the Internet, please ask your dealer for a copy.

Installing BLL Generator from the Web Site
Run “WinBLL.exe“. Follow the prompts of the setup program.

Click Start->Programs->WinRascol32->BLLConf and select “Add/Manage BLL Generators” to install
one or more BLL generator drivers.

Installing Windows BLL Generator using Windows BLL Generator
installation disks
Run “setup.exe“. Follow the prompts of the setup program. Start “WinRascol32->BLLConf” and select
“Add/Manage BLL Generators” to install one or more BLL generator drivers.
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Chapter 3: Software Installation

This section explains how to install Windows BLL Generator on your computer. The installation is
performed in two steps, the initial installation and running BLLConf.
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Running setup
These steps perform the initial installation of the Windows BLL Generator package.

• Close all programs currently running.

• Insert disk 1 of the Windows BLL Generator installation disk set, skip this step if you’ve
downloaded the Windows BLL Generator from the web site.

• Press Start  on the Windows tool bar, then select Run .

• If you are using installation disks enter “a:setup“ in the “run“ dialog box as follows:

• If you’ve downloaded the Windows BLL Generator or have received it from another source, use
the Browse  button to point to it.

• Press OK. Setup now prepares the installation.

• Press Next  after reading the introductory screen.

• Press Next  after reading the readme file.

• You will be asked to select a destination directory at this time. It is strongly suggested that you
use the default directory offered by the installation program. Press Next.

• Setup is now ready to install Windows BLL Generator. Press Next  to install now.

• Setup will install all program files at this time. Follow setup’s instructions to insert additional
disks if needed.

• Press Finish  to exit setup.

• Setup may ask you to reboot your computer in rare cases.

The Windows BLL Generator program files are now installed.
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Adding a BLL-Generator
Start BLLConf  in Start->WinRascol32 . Select Add/Manage BLL Generators .

This dialog will appear:

• Select Add generator .
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The following dialog is displayed:

• Select the destination film recorder type in Film recorder type .

• Enter the serial number of the target film recorder in the Serial number  edit box.

• Windows BLL Generator will select a default name for you.  You can modify the name of the
printer driver in the edit box Driver name .

• Select the destination directory into which the BLL files will be placed. Windows BLL Generator
will select the default temporary file path as default. You should select the network path of a
WinRascol drop box if you intend to use a film recorder that is connected to your network.
Contact your network administrator for details. You can also select the path of a ZIP-Drive, for
example.

• Press OK to create the BLL driver.

The BLL driver will now appear in the BLL-generator Administration dialog. Press Done  to exit.

� NOTE: For technical reasons, the new BLL-generator will show LPT1:  to be the selected output
port on Windows 95/98 until your computer is rebooted. After reboot, the new generator will
show BLL: . This affects appearances only, it does not impact operation of the BLL-generator in
any way.
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Chapter 4: Printing your first image

This guided tour will show you how to print from an application.

You must have completed the software installation successfully to follow this tour.
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Printing from an Application
This section will show you how to print an image using Microsoft Wordpad. Wordpad is included in both
Windows 95/98 and Windows NT. But you can use any other Windows application instead.

Start Microsoft Wordpad. You will find it in

Start->Programs->Accessories->Wordpad.

Punch in a few letters. Wordpad should look like this now:

Feel free to format the text any way you like!
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Now open the Wordpad print dialog by selecting Print...  from the File  menu.

Select the BLL Generator in the Name field.

� Note: You should never check the “Print to file” check box.
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Now select Properties . This will open a dialog that allows you to set film recorder print settings:

This is the Windows 95 film recorder settings dialog. The Windows NT dialog is shown in “Printer
settings in Windows NT” on page 48.

• Select the film type you intend to use in Film Type .

• Select Standard Slide  as the page size in Output Size .

• Select White  as Background Color . Wordpad assumes white background but doesn’t fully
paint it.

• Press OK.
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• Now press OK in the Print  dialog. A BLL will be created in the directory you designated at
installation time.
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Viewing a BLL
You can preview the BLL you just created by using Windows Explorer to locate the file in the directory
you designated during installation and double clicking on it.

The BLL Viewer will show you the rastered file:

Note that the printer driver has automatically rotated the image because the film recorder only images in
landscape orientation.
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Chapter 5: Principle of Operation

This section explains how the Windows BLL Generator and WinRascol work together to produce film
output.

Introduction
WinRascol consists of two software components:

• WinRascol32:  The queue and print manager. It queues print jobs and sends them to the film
recorder. WinRascol32 is the same program on Windows 95, Windows 98 and Windows NT.

• WinRascol Printer Driver, or Windows BLL Generator:  The printer driver is used when you
invoke the Print  command from within a Windows application. Due to architectural differences
between Windows 95/98 and Windows NT, there need to be separate printer drivers for each
type of operating system.

There are several different ways to use WinRascol:

• The user on a PC with a film recorder attached can print by:

• Printing directly from an application with the WinRascol Printer Driver, or

• Adding image files directly to the queue with WinRascol32.

• The user on a PC  without a film recorder can:

• Print from an application with the Windows BLL Generator to make BLL files, or

• Save images in one of the formats that WinRascol supports directly.
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BLLs and other image files should be placed into dropbox directories that are serviced automatically by
a PC with WinRascol.  If dropbox directories are not accessible, BLL and other image files can be
copied to a disk and later added to WinRascol on the PC with a film recorder.

� NOTE:  Image files in dropbox directories will be automatically deleted after they are printed.
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Printing from Windows on a PC without Film Recorder
Producing slides from Windows applications on a PC without film recorder is a simple four-step
process.

• Select a BLL-generator Driver as the output device for the Windows application on the PC.

• Create the images with the application.

• Print the images using the Print command from within the application on the client PC.
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Here is a diagram showing how this works:
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� NOTE: The dropbox directory can be located on a network server or on the server PC.
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Important Concepts
This section explains resolution, color fidelity, and the differences between bitmaps and objects.

Resolution
Resolution can be defined in many ways.  Dots per inch (DPI) is a common definition, but an impractical
one for slides and overhead transparencies because the DPI changes significantly when the image is
projected.

The most practical definition of resolution is the total number of dots (or pixels) in the image.  The
following table compares the image resolution of several graphics output devices.

Device Dots Image Resolution approx. DPI

VGA screen 640 by 480 307,200 58 (on 17” CRT)

Most laser printers 2400 by 3276 7,862,400 300

All LFR film recorders 4096 by 2731 11,186,176 2790 (on 35mm film)

LFR Mark III, Mark V 8192 by 5461 44,736,512 5945 (on 35mm film)

LFR Mark VI 16384 by 13438 220,168,192 11890 (on 35mm film)

Images produced by the LFR Mark VI contain over 716 times more dots than images on a VGA screen.
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When discussing film recorder resolution, the terms 2000-line slide, 4000-line slide and 8000-line slide
are commonly used.  The number of lines refers to the number of dots across the image. Examples:

2000-Line Slide 4000-Line Slide 8000-Line Slide

� NOTE: High end Lasergraphics film recorders can image up to 16384x13448 dots. This is
called 16000-line resolution. Some camera backs have a different aspect ratio that enables the
film recorder to output at higher vertical resolution like 4096x3362. This is still called 4000-line
resolution.

Color Fidelity
Color fidelity refers to the range of colors that can be reproduced in an image.

The range of colors that can be represented is defined by the number of bits per pixel  used to store an
image.  The more bits per pixel, the greater the range of colors.

Windows BLL Generator supports 24-bits per pixel, 8 for each of red, green, and blue.  This results in
256 shades of each primary color, which can combine to form 16.7 million colors.  Each pixel in an
image can be a different color.
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Bitmaps and Objects
Images can contain bitmaps , objects , or both.  Bitmaps consist of dots or pixels. Objects consist of
mathematical descriptions of a shape, such as a polygon or line.  Applications that create bitmaps are
often called “paint” programs and those that create objects are often called “draw” or “illustration”
programs.  Both graphics and text can be bitmaps or objects.

Graphics

At high-resolution, bitmaps look the same if the film recorder resolution exceeds the resolution of the
bitmap but objects get sharper.

You can usually tell bitmaps from objects by watching how the image is created when it is first displayed
on the screen.  Bitmaps are usually drawn on the screen from top to bottom in one chunk.  Objects are
assembled in pieces.

Text

Text can be a bitmap or an object, just as graphics can.  Text that is part of a bitmapped graphic with
lower than film recorder resolution remains jagged at high-resolution.  However, text that is an object
can get sharper when output at high-resolution.

Text created with ATM (Adobe Type Manager ) or TrueType  fonts is sharp at any size and resolution.
In addition, ATM and TrueType fonts will look the same on screen as on the slides printed by
WinRascol.
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Which Applications Create Bitmaps or Objects

Most images contain either bitmaps or objects, but some images can contain both.  Here are some of
the more popular applications:

Bitmaps

• Adobe® Photoshop TM

• Aldus® PhotoStyler TM

• Microsoft® Paint

• ZSoft Corp. Publisher's Paintbrush®

Objects

• Aldus® PageMaker®

• Aldus® Persuasion®

• Computer Support Corp. Arts & Letters®

• CorelDRAW!®

• Harvard® Draw

• Harvard Graphics®

• Lotus Freelance Graphics®

• Micrografx® Charisma TM

• Micrografx® Designer TM

• Microsoft® PowerPoint®

• Microsoft® Excel®

Images from these applications may contain bitmaps that have been imported.

Both

• Deneba CanvasTM

• CorelDRAWTM

• PowerPointTM

• Lotus FreelanceTM
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Chapter 6: Reference

This chapter provides detailed information about how to use Windows BLL Generator.

Printer Settings
Many Windows BLL Generator components will let you modify a wide variety of imaging options. This
section explains these options in detail. Later sections will explain where these options apply and how
to access them.

Resolution
Resolution controls the number of dots in the image according to the following table:

Name Short 35mm resolution 120/220/4x5 resolution Available on

Fast 2k 2048x1365 2048x1680 All

Fine 4k 4096x2731 4096x3360 All

Extra 8k 8192x5461 8192x6719 Mark III and above

Ultra 16k 16384x10923 16384x13438 Mark VI
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Note that the time it takes to image a slide will increase with the resolution setting approximately as
follows:

Resolution 2k 4k 8k 16k

Relative resolution 0.25 1 4 16

Relative imaging time 0.75 1 4 16

Approximate imaging time 30s 40s 150s 600s

Relative resolution  is the total number of pixels relative to a 4k slide.

Relative imaging time  is the time it takes to image relative to a 4k slide, on a theoretical basis.

Approximate imaging time  is the time it minimally takes to image a slide in real life.

Orientation and Paper Size
Orientation specifies whether the output should be in Landscape  or Portrait  mode.

Landscape
Portrait

Paper size determines the paper dimensions returned to the application.

� NOTE: Paper size does not correspond to the actual size of the film.

� NOTE: Make sure to match the paper size and orientation settings of the printer driver with
those of your application. Some applications will ignore paper dimensions returned by the
printer driver. Paper size and orientation mismatches can lead to badly sized images.
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Film Type
Film Type  specifies the type of film in the camera back connected to the film recorder. Windows BLL
Generator supports two types of film, LFC-based and non-LFC based. LFC based film choices rely on
so-called LFC files that reside in the LGDATA\LFC directory. These LFC files contain transfer functions
for specific film/film recorder combinations. The transfer functions of non-LFC based films have been
pre-programmed into the film recorders.

� NOTE: Choose LFC-based films over non-LFC-based films when possible!

Non-LFC based Film Types

Use Ektachrome 100 (35mm)  with:

• 35mm camera back

• ISO daylight balanced slide film such as Ektachrome 100, Fujichrome 100 or Agfachrome 100

• All film recorders except the Digital Photography Models

Use Polachrome  with:

• 35mm camera back

• Polachrome instant 35mm slide film. You process the slides yourself using the Polaroid 35mm
Autoprocess System. Polachrome slides are only draft quality, but are useful if time or
confidentiality is important.

• All film recorders

Use Polaroid 339  with:

• Polaroid camera back

• Polaroid Instant Print film, which produces 4"x 3" instant prints. It is convenient for making test
prints and single print images.

• All film recorders except the Personal LFR and the Personal LFR PLUS

Use Polaroid 669  with:

• Polaroid camera back

• Polaroid Instant Pack film, which produces 3 3/4"x 2 7/8" instant transparencies

• All film recorders except the Personal LFR and the Personal LFR PLUS

Use Polaroid 691  with:

• Polaroid camera back
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• Polaroid 691 Overhead Transparency film, which produces 3 3/4"x 2 7/8" instant transparencies

• All film recorders except the Personal LFR and the Personal LFR PLUS

Use Kodacolor 100  with:

• 35mm camera back

• ISO daylight balanced print film

• All film recorders except Digital Photography Models

Use Ektachrome 100 (4x5 ) with:

• 4x5 camera back

• Ektachrome 100 4x5 film

• All film recorders except the Personal LFR., Personal LFR PLUS, LFR-X, and the Digital
Photography Models

Use Ektachrome 100 (120/220 ) with:

• 120 or 220 camera back

• Ektachrome 100 film

• LFR Mark II and LFR Mark III standard film recorders only

LFC-based Film Types

In addition, Windows BLL Generator supports Lasergraphics Film Calibration (LFC) files. These LFCs
support a variety of film types such as Kodak Gold 100 Plus, Vericolor III, etc. Each Lasergraphics Film
Calibration file provides calibration data for one film on one specific film recorder model. For example,
the 35mm Vericolor III LFC file for LFR Mark III will be different from the one for LFR Mark III - Digital
Photography Model.
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Background Color
Background Color  specifies the background color of the image.  This setting is ignored if the
application explicitly sets the background color in the image. Use Background Color to set the color of
unpainted regions to white for text applications like Word. Otherwise, you might end up with black text
on black background!

Scaling
Scaling  controls how the image is scaled for output.  100% keeps the image size unchanged.  To
shrink the image, set the value to less than 100%.  To expand the image, set the value to greater than
100%.  The range of valid scaling values is 20% to 400%.

Minimum Exposure Time
This setting  applies mostly to very old film recorders that have no internal slice mark control
mechanisms. Minimum Exposure Time controls the exposure time of the film recorder to eliminate slice
marks (periodic faint horizontal lines) on the output.  Normally Fastest Possible should be selected.  If
there are slice marks on the output slide, set the minimum exposure time to 1.5 times the normal
processing time of the image.  If slice marks are still there, increase the value and try again.

Color Balance
Color balance  controls the percentages of red, green and blue used in the film recorder.  Normally,
each of the three colors is set to 100%.  The range of valid color balance values is 25% to 400%.
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Contrast Gamma
Contrast Gamma  allows for very fine contrast adjustment.  The range of valid gamma contrast values
is 0.14 to 7.0.  However, values between 0.25 and 2.0 are usually more practical.  By adjusting the
gamma contrast value you can change the midtones of the image without affecting the highlights.  As
the gamma contrast value decreases, output midtones become darker.  As the gamma contrast value
increases, output midtones become lighter.

The graph under the scroll bar for gamma contrast adjustment (only available in some dialogs) shows
how input intensities are mapped to output intensities.  The horizontal axis represents input intensities
which increase from left to right.  The vertical axis represents output intensities which increase from
bottom to top.
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Using the Windows 95/98 driver
Printing a document or image to a film recorder from an application is just like printing to any ordinary
printer. This process will vary slightly from application to application, but generally the Print command in
the application’s File menu will do the trick.

Printer settings in Windows 95/98
The printer driver allows changing a number of print settings. Most of these settings don’t need to be
changed in many cases, but you will always need to select the film type you want to use. The Print
dialog generally has a button that allows you to access the printer settings dialog.

Please see “Printer Settings” on page 35 for details on individual settings.
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This is the printer settings dialog in Windows 95.

• Choose the desired resolution in the Resolution  box. Note that not all film recorders and film
types support all resolutions. Up to four different resolutions are available:

• 2k – Fastest selection – up to 2048 x 1680 pixels

• 4k – Fine resolution – up to 4096 x 3360 pixels

• 8k – Extra fine resolution – up to 8192 x 6719 pixels

• 16k – Ultra fine resolution – up to 16384 x 13438 pixels

Note that the higher the resolution, the longer it will take to print the image on the film recorder. As
a rule of thumb, 2k images will take at least 30 seconds, 4k images will take at least 40 seconds,
8k images will take at least 150 seconds and 16k images will take at least 600 seconds. The exact
times will vary with the complexity of the image, the speed of the interface, the film type and the
type of film recorder used.
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• Orientation  selects the image orientation.

• Output Size  selects the “paper” format to use. This should match the paper format selected in
your application. You will generally get best results with the default “Standard Slide”. You can
also select a user defined paper size

� NOTE: Make sure to match the paper size and orientation settings of the printer driver with
those of your application. Some applications will ignore paper dimensions returned by the
printer driver. Paper size and orientation mismatches can lead to badly sized images.

• Film selects the film to use.

Download from Www.Somanuals.com. All Manuals Search And Download.



44 Reference

Color balance and gamma correction

• Color Balance  controls the brightness of the three color channels.

• Gamma Correction  controls the gamma correction. It is used to brighten or darken mid tones
of an image without changing the very dark and very bright pixels.
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Miscellaneous options

• Compression  selects a compression type for the BLL. Medium compression optimizes for
speed, while high compression optimizes for file size. Use high compression when you want to
send BLLs to a service provider using removable media or the Internet.

• Scale  scales your image. The range is 25% to 400%. Note that scaling your image may result in
non-optimal use of film.

• Minimum Exposure Time  is used to lengthen the imaging time in rare cases of slice marking.
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• Background Color  selects the color that is used to paint the background. This color is used in
cases where the application does not specify a background color and when the aspect ratio of
the paper selected in the application doesn’t match the aspect ratio of the film.

The options Aspect Ratio, Raster Options and AntiAlias don’t apply for non-raster operations.
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Changing the Default Printer Settings in Windows 95/98
The document default printer settings are used automatically when an application initializes the printer
settings of a document, usually when a document is created and when the selected printer is changed.
By setting the document defaults to the settings you normally use, you can simplify using the printer
driver.

You can find the default document settings by:

Selecting Start->Settings->Printers

right-clicking on the film recorder

selecting 'Properties’->’Details’->’Setup’

The default document settings dialog is the same as the printer settings dialog described in “Printer
settings in Windows 95/98” on page 41.
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Using the Windows NT driver

Printer settings in Windows NT
Printing a document or image to a film recorder from an application is just like printing to any ordinary
printer.  This process will vary slightly from application to application, but generally the Print command
in the application’s File menu will do the trick.

The printer driver allows changing a number of print settings. Most of these settings don’t need to be
changed in many cases, but you will always need to select the film type you want to use. The ‘Print”
dialog generally has a button that allows you to access the printer settings dialog.

Please see “Printer Settings” on page 35 for details on individual settings.
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The printer settings dialog looks like this:

• Selecting Paper Size : Select 'Paper Size' in the upper window, then choose a form in the lower
window. Default is 'LFR Standard Slide 7.33x11in'.

• Selecting Orientation : Select 'Orientation' in the upper window, then choose 'Portrait' or
'Landscape' in the lower window. The driver will rotate the rasterized image to fit the form on the
film using as much film as possible. Default is 'Portrait'.

• Selecting Copy Count : Select 'Copy Count' in the upper window, then choose the number of
copies in the lower window. Default is 1.

• Selecting Resolution : Select 'Resolution' in the upper window, then choose 2k, 4k, 8k or 16k in
the lower window. Note that not all film recorders support all resolutions. Default is 4k.
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• Selecting Background Color : Select 'Background Color' in the upper window, then choose
'black' or 'white'. The background color determines the color imaged on film for areas that the
application decides not to rasterize on. The background color is also applied to areas that are
not imaged by the application due to the fit of the form on the film. Options are black and white.
Default is black. Select ‘White’ for text applications like Word that expect white paper.

• Selecting Exposure Speed : Select ‘Exposure Speed' in the upper window, then choose a
minimum exposure time in minutes. This setting selects the minimum time for the exposure. It is
used to slow down the film recorder in rare cases of banding. Default is 0 for maximum speed.
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• Selecting Gamma Correction : Select 'Gamma Correction' in the upper window, then choose a
gamma value between 0.144 and 7. Default is 0.500.

• Selecting Color Balance : Select 'Red', 'Green' or 'Blue' in the upper window, then set a
balance value between 25 and 400. Default is 100 for red, green and blue.

• Compression  selects a compression type for the BLL. Medium  compression optimizes for
speed, while high compression optimizes for file size. Use high compression when you want to
send BLLs to a service provider using removable media or the Internet.

Storing Changed Settings

Press OK to store changed settings. 'Cancel' will undo all changes.
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Changing the Default Printer Settings in Windows NT
The default document settings are used automatically when an application initializes the printer settings
of a document, usually when a document is created and when the selected printer is changed. By
setting the document defaults to the settings you normally use, you can make your life easier.

You can find the default document settings by:

Selecting Start->Settings->Printers

right-clicking on the film recorder

selecting 'Document Defaults…'

The default document settings dialog is the same as the printer settings dialog described in “Printer
settings in Windows NT” on page 48.

Please see “Printer Settings” on page 35 for details on individual settings.
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Managing BLL-Generators
Open the BLL management dialog by selecting Start->WinRascol32->BLLConf  and pressing
Add/Manage BLL Generators . The dialog looks like this:

This is the dialog:

Adding a BLL-Generator

• Select Add generator . The following dialog is displayed:

• Select the destination film recorder type in Film recorder type .

• Enter the serial number of your film recorder in the Serial number  edit box.

• You can modify the name of the printer driver in the edit box Driver name . Windows BLL Generator
will select a default name for you.

• Select the Destination directory in which the BLL files will be placed. Windows BLL Generator will
select the default temporary file path as default. You should select the network path of a WinRascol
drop box if you intend to use a film recorder that is connected to your network.
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• Press OK to create the BLL driver.

The BLL driver will now appear in the BLL-generator Administration dialog.

Changing Destination Path

Select Change Path  in the BLL-generator administration dialog. A dialog will appear to allow you to
change the destination path. The destination path points to the directory in which generated BLLs are
placed.

Deleting a BLL-Generator

Select a BLL driver in the BLL-generator Administration dialog by clicking on it. Press Delete
generator . The BLL-generator will be deleted.
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Modifying Driver Options
Open the Global driver settings dialog by selecting Start->WinRascol32->BLLConf  and pressing
Configure Drivers . The dialog looks like this:

• Disk space usage  sets the amount of free disk space the driver leaves minimally before
reporting  Disk Full .

• Enable Power Smoothing Technology:  This option enables a post processing feature that
attempts to correct a gradient fill problem of PowerPoint 97. Gradient fills printed from
PowerPoint 97 have very coarse steps and exhibit visible banding on high quality film recorders.
This option interpolates between bands to ease the effect.

• Enable Lotus Freelance Workaround:  This switch enables a workaround for a bug in Lotus
Freelance 97. Freelance 97 will preview and print in black and white on true color printers.
Enabling this switch hides the fact that Lasergraphics film recorders are true color devices from
applications.

� Note:  Enabling this switch may affect printing from other applications adversely.

� Note: Lotus will try to fix this problem in future releases.
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Chapter 7: Uninstalling

When to use the Uninstaller
The uninstaller is used to remove all components of the Windows BLL Generator from your computer.
You will want to do this when

• You do not intend to use Windows BLL Generator on your computer any longer.

• The Windows BLL Generator  installation has been corrupted. While you can reinstall Windows
BLL Generator over a corrupted installation of Windows BLL Generator, this is not
recommended.

You do not need to uninstall Windows BLL Generator when

• You want to install an update of Windows BLL Generator.

• You have used a Windows BLL Generator and now want to attach a film recorder directly.

• You have used a film recorder directly using WinRascol but want to install a BLL-generator.
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How to use the Uninstaller
You can uninstall the Windows BLL Generator package by selecting Uninstall  in the WinRascol32
program group. Uninstall will do the following:

• Remove all Windows BLL Generator printer drivers

• Remove all Windows BLL Generator system drivers (NT only)

• Remove all Windows BLL Generator program and data files

• Remove all Windows BLL Generator related entries in the WIN.INI

• Remove all Windows BLL Generator entries in program groups (Startup and WinRascol32)

� NOTE: It is best to run Uninstall  after rebooting the computer and exiting all programs. Some
programs tend to leave printer drivers activated. Uninstall will fail in this case.
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Chapter 8: Tips and Tricks
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This section gives tips and tricks on particular image types and applications.

Specific Applications

Adobe Type Manager (ATM)
Windows BLL Generator is fully compatible with Adobe Type Manager  (ATM) fonts, version 1.15 or
newer.  These fonts produce smooth text at any size and match text layout in your output with your
image on screen.

In ATM Control Panel, make sure the Print ATM fonts as graphics  option is checked; otherwise, very
large ATM text may be missing in your output.

Arts & Letters
The long names of Windows BLL Generator devices may cause problems with Arts & Letters. To get
around the problems, you can shorten the Windows BLL Generator device names:

1. Open Start->Settings->Printers

2. Select the Windows BLL Generator printer

3. Use File->Rename  to shorten the name of the printer

Corel Draw
In order to get a realistic preview of the document, be sure that the color selected as the Paper Color  in
CorelDRAW's Page Setup  window matches with the Background Color  in Windows BLL Generator
Driver's setup window. For example, when printing to the film recorder, Windows BLL Generator's
default background color is black.  Set Paper Color in CorelDRAW's Page Setup window to black, so
that the preview of the image in CorelDRAW will be correct.

If you are using CorelDRAW 3.00 Rev B or later, adding the following entry to the [CDrawConfig]
section of the CORELDRW.INI file will significantly improve the printing times of certain images:
UseClippingForFills=0

In the Print window of CorelDRAW, make sure the Print to File  box is not  checked.

Corel Draw 7
When using gradient fills in Corel Draw 7, make sure to select the highest number of steps at every
opportunity to avoid banding. Especially in the dialog hidden under Print��Options->Options.

Also make sure to disable color management for composite print under Tools->Color Manager.  This
will prevent the very strange discoloration caused by the default profile.

Download from Www.Somanuals.com. All Manuals Search And Download.



Specific Applications 61

CorelDRAW 8
CorelDRAW 8 will generate erroneous output when you choose a value higher than 256 for the number
of fountain steps in the miscellaneous printer options. CorelDRAW 8 will even crash while printing
gradient fills if the number is very high, like 2000.

Freelance Graphics for Windows Ver 1.0
If the text and/or objects on your slides are printed with a different color than those on your screen, do
the following:

1. In the Page Setup  window of Freelance, click on Color Map .

2. Select Use Window's color map .

All bitmaps will appear in black and white when printed with Windows BLL Generator.  This problem is
fixed in Freelance Graphics for Windows ver 2.0.

Freelance Graphics 97
Freelance Graphics 97 has a bug that makes it preview and print in black and white to true color
devices like Lasergraphics film recorders. Please enable the Lotus Freelance Workaround  outlined in
“Modifying Driver Options” on page 55 if you experience this problem.

Persuasion
To make Persuasion print faster to Windows BLL Generator, you can modify the ALDUS.INI  file.  (The
ALDUS.INI  file is usually located in the USENGLSH subdirectory under your ALDUS directory.)  Use a
text editor (such as EDIT.COM from MS-DOS or NotePad  from Windows) to add the following lines to
the end of the ALDUS.INI  file:

[ your_Windows BLL Generator_printer_name]

NoPatternOnlySolidFill=0

ROPtype=0

StretchImage=0
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where your_Windows BLL Generator_printer_name is the name of the Windows BLL Generator printer
as shown in the Installed Printer List of the Control Panel .  For example, if you have an LFR, the lines
you should add are:

[LFR]

NoPatternOnlySolidFill=0

ROPtype=0

StretchImage=0

If you have a Personal LFR, the lines you should add are:

[Personal LFR]

NoPatternOnlySolidFill=0

ROPtype=0

StretchImage=0

After you have changed the ALDUS.INI  file, restart Windows.

� CAUTION:  Please make sure the lines you are adding follow exactly  the format described
here.  A spelling mistake or an extra space may cause Persuasion to ignore these lines with no
warning.

PhotoStyler
You must check the Halftone by Printer  box in PhotoStyler's Page Setup  window.  Otherwise,
PhotoStyler will limit the bitmaps to 16 colors when printing to Windows BLL Generator Driver.

If you choose Scale to Fit  in the PhotoStyler's Print  window, PhotoStyler will resample bitmaps to the
film recorder's resolution instead of letting Windows BLL Generator do the work.  This will make
Windows BLL Generator print job files very large and make the processing very slow.

Word, Write
These applications assume a white background and always print text in black.  So, when printing to the
film recorder, you must explicitly select a white Background  in Windows BLL Generator Driver's setup
window.  Otherwise, you will get black text printed on a black background.
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Appendix A: Specifications

Specifications are subject to change without notice.

Supported PCs Any IBM PC compatible with a 486 processor or better and at least
16 MB of memory. Note that this represents the absolute minimum.
You will need more memory if you intend to use Windows NT or
have graphics intensive images.

Supported Output Devices All film recorders in the Lasergraphics LFR family are supported:

• Personal LFR

• Personal LFR PLUS

• LFR-X

• LFR Mark II

• LFR Mark II - Digital Photography Model (DPM)

• LFR Mark III

• LFR Mark III - Digital Photography Model (DPM)

• LFR Mark V - Digital Photography Model (DPM)

• LFR Mark VI - Digital Photography Model (DPM)
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Supported Operating
Environment

Windows 95, Windows 98, Windows NT 4.0 and Windows NT 5.0

Image Enhancements Color balance

Gamma contrast

Fonts TrueType

ATM (Adobe Type Manager) ver 1.5 or later

Software Selectable
Resolution (Film Recorder)

4000 lines (4096 x 2730 pixels)

2000 lines (2048 x 1366 pixels)

On LFR Mark III, LFR Mark III - Digital Photography Model, LFR
Mark III – Digital Photography Model and LFR Mark V – Digital
Photography model 8000 lines (8192 x 5461 pixels) are available.
On the LFR Mark VI – Digital Photography Model 16000 lines are
available

Film Types Ektachrome 100 color slides

Kodacolor 100 color prints

Other ISO 100 films

Polachrome instant slides

Polaroid 339 Print instant prints (with optional Polaroid camera)

Polaroid 669 Print instant prints (with optional Polaroid camera)

Polaroid 691 instant transparencies (with optional Polaroid camera)

Ektachrome 100 4x5 transparencies (with optional 4x5 camera)

Ektachrome 100 Color Reversal 120/220 film (with optional 120
camera)

Lasergraphics Film Calibration (LFC) files, currently 176 film type
and film recorder combinations
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Glossary
antialiasing    Assigning pixels at the edges of objects a graduated gray scale of values.  This
dramatically reduces the appearance of jaggies.

Binary Lasergraphics Language (BLL)    A proprietary print job format.

bitmap    A type of graphic composed of a rectangular group of colored dots.  Bitmaps have jagged
edges when output at high-resolution.

BLL    An abbreviation for Binary Lasergraphics Language.

camera back   A film recorder's camera.

client computer    A computer without a film recorder.  Users on client computers can put image files in
dropboxes  so that the WinRascol server PC  can pick up the image files and print them.

contrast   Measures the range of shades between light and dark.  Black and white is high contrast,
whereas two similar shades of gray is low contrast.

crop   To trim an image prior to output.

DPI   Dots per inch.  Commonly used to specify printer resolution.

DPM   Digital Photography Model.  A film recorder model that is customized for digital photography.

Dropbox   A shared directory where network users can put image files.  A dropbox directory is scanned
by WinRascol periodically for image files to process.  Dropboxes make film recorder sharing very easy.

font   A typeface.

HPGL   A popular computer-aided design drawing format on PCs.

jaggies   Within an image, steps along the edge of a shape that should be smooth.  Jaggies are
reduced by increasing resolution  and/or antialiasing .

landscape    An output orientation where the width is greater than the height.  Also known as horizontal
or wide format.  Compare to portrait .
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Lasergraphics Language   A powerful graphics language that is common in the mainframe and
minicomputer environments.

Lasergraphics Film Calibration file    A file that provides calibration data of a film type for a specific
LFR model.  Therefore, the LFC file of 35mm Vericolor for LFR Mark III is different from the one for LFR
Mark III - Digital Photography Model.

LFC file   See Lasergraphics Film Calibration file.

LFR   Lasergraphics Film Recorder.  Refers to a family of film recorders including the LFR, LFR PLUS,
Personal LFR, Personal LFR PLUS, LFR-X, LFR Mark II and LFR Mark III, and the Digital Photography
Models Mark II DPM, Mark III DPM, Mark V DPM and Mark VI DPM.

LL   An abbreviation for Lasergraphics Language.

object   A type of graphic composed of graphic primitives (e.g. circles, lines, polygons, etc.).  The
graphic primitives are represented by their mathematical coordinates.  Objects reproduce well at high-
resolution.

output   To create an image on a film recorder.

pixel   An acronym for picture element.  A pixel is a single dot on your monitor or output device.

portrait   An output orientation where the height is greater than the width.  Also known as vertical or tall
format.  Compare to landscape .

printer driver   Software that knows how to communicate with a printer device.

queue   A directory on your hard disk for storing temporary Windows BLL Generator print job files.

Rascol    Refers to a family of high speed Lasergraphics image processors.  Instead of burdening the
PC, WinRascol lets the Rascol perform the time- and memory-consuming task of rasterization.  This
way you can continue to do work on your PC while the Rascol is busy rasterizing.  The Rascols also
control the Lasergraphics film recorders. These days PCs have become so fast that they usually
rasterizer faster than Rascol devices.

Rascol II   A Rascol model that plugs into your PC and acts as a fully independent co-processor that
performs rasterization and controls the film recorder.

Rascol IV   A Rascol model that plugs into your PS/2 and acts as a fully independent co-processor that
performs rasterization and controls the film recorder.

RascolPort   A high performance communication port for connecting to RISCRascol and Internal
Rascol.  It can emulate the standard bi-directional parallel (LPT) port to work with most third party
printers.

raster    See bitmap.

rasterization    A time- and memory- consuming process for converting graphics objects into rasters for
output.

resolution    The total number of dots in an image.  Film recorder resolutions measured in lines
represents the number of dots across the image.
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RISCRascol   A Rascol model that offers dramatic speed increase for the Lasergraphics film recorders.
For complex images, the RISCRascol is 15 times faster than the Rascol II/IV.

server PC    A PC connected to a film recorder .  The PC can run WinRascol Network Version to share
the film recorder with other network users via dropboxes .

TARGA    A popular bitmap file format for PCs.

TIFF   A popular bitmap file format for PCs.
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Index

24-bit color, 14

35mm prints, 13

35mm slides, 13

Adobe Type Manager, 33,
60

Application

Printing from, 22

applications

draw, 33

illustration, 33

paint, 33

Arts & Letters, 34, 60

ATM, 33, 60

auto deletion, 28

Background Color, 39, 50

Bitmap, 33

BLL-generator

Add, 53

Adding, 19

Change path, 54

Delete, 54

Manage, 53

Canvas, 34

Charisma, 34

Client Computers

printing on, 27

Color

Background, 39, 50

fidelity, 32

true-color, 14

Color Balance, 39, 44, 51

Contrast

Gamma, 40, 44

Copy count, 49

CorelDRAW, 34, 60

Designer, 34

dropbox, 28

Excel, 34

Exposure Speed, 50

Exposure Time, 39, 45

Film

LFC based', 38

Non LFC based, 37

film transparencies, 13

Film Type, 37, 43

Ektachrome 100
(120/220), 38

Ektachrome 100 (4x5),
38

Kodacolor 100, 38

Lasergraphics Film
Calibration files, 38
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LFC files, 38

Polachrome, 37

Polaroid 339, 37

Polaroid 669, 37

Polaroid 691, 37

Film Types, 64

font

ATM, 33, 60

Freelance, 34, 61

Freelance Graphics for
Windows, 61

Gamma, 51

Contrast, 44

Guided tour, 21

Hardware

Required, 10

Harvard Graphics, 34

Lasergraphics Film
Calibration files, 37, 38

LFC files, 37, 38

LFR, 13

Microsoft Word, 62

objects, 33

Orientation, 36, 43, 49

Output Size, 36, 43

PageMaker, 34

Paper Size, 36, 43, 49

Persuasion, 34, 61

Photoshop, 34

PhotoStyler, 34, 62

Polaroid prints, 13

PowerPoint, 34

Printer Driver, 27

Windows 95/98, 41

Windows NT, 48

Printing

From application, 22

Reference, 35

Resolution, 35, 42, 49

defined, 31

image resolution, 13

Scaling, 39, 45

Server PC

printing on, 27

Settings, 35

Default, 47, 52

Windows 95/98, 41

Windows NT, 48

Setup, 18

slice marks, 39

slide

2000-line, 32

4000-line, 32

8000-line, 32

Specifications, 63

text

bitmap, 33

object, 33

Uninstalling WinRascol, 57

What’s new, 12

Windows 3.1x, 12

WinRascol

About, 13

Installation, 17

Version 3.15, 12

What’s new, 12

WinRascol Driver

Lasergraphics Film
Calibration files, 38

LFC files, 38

WinRascol32, 27

Installation, 18

Word, 62

Download from Www.Somanuals.com. All Manuals Search And Download.



Free Manuals Download Website
h�p://myh66.com

h�p://usermanuals.us
h�p://www.somanuals.com

h�p://www.4manuals.cc
h�p://www.manual-lib.com
h�p://www.404manual.com
h�p://www.luxmanual.com

h�p://aubethermostatmanual.com
Golf course search by state

h�p://golfingnear.com
Email search by domain

h�p://emailbydomain.com
Auto manuals search

h�p://auto.somanuals.com
TV manuals search

h�p://tv.somanuals.com

http://myh66.com/
http://usermanuals.us/
http://www.somanuals.com/
http://www.4manuals.cc/
http://www.manual-lib.com/
http://www.404manual.com/
http://www.luxmanual.com/
http://aubethermostatmanual.com/
http://www.golfingnear.com/
http://emailbydomain.com/
http://auto.somanuals.com/
http://tv.somanuals.com/

	C
	Chapter 1: Introduction
	What You Need
	Required Hardware
	Required Software

	About this Guide
	What™s new
	Windows BLL Generator Features
	Various Output Types
	High-Resolution
	True Color
	Easy to Use and Highly Compatible

	C

	Chapter 2: Express Setup
	Installing Windows BLL Generator
	Installing BLL Generator from the Web Site
	Installing Windows BLL Generator using Windows BLL Generator installation disks


	C
	Chapter 3: Software Installation
	R
	Running setup
	A
	Adding a BLL-Generator

	C
	Chapter 4: Printing your first image
	Printing from an Application
	Viewing a BLL

	Chapter 5: Principle of Operation
	Introduction
	Printing from Windows on a PC without Film Recorder

	Important Concepts
	Resolution
	Graphics
	Text
	Which Applications Create Bitmaps or Objects



	Chapter 6: Reference
	P
	Printer Settings
	
	Non-LFC based Film Types
	LFC-based Film Types


	U
	Using the Windows 95/98 driver
	Using the Windows NT driver
	
	Storing Changed Settings


	M
	Managing BLL-Generators
	
	Adding a BLL-Generator
	Changing Destination Path
	Deleting a BLL-Generator



	Chapter 7: Uninstalling
	When to use the Uninstaller
	How to use the Uninstaller

	C
	Chapter 8: Tips and Tricks
	Specific Applications

	Appendix A: Specifications
	G
	Glossary
	I
	Index		

